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Introduction
Tap Forms is a very powerful organizational tool designed to help you keep track of all your life’s most
important information at home, at work, or on the go. With built-in support for iCloud, now you can keep all
your Tap Forms data on your iPhone and iPad in sync with your Mac. So when you’re out and about and
you need to lookup some important piece of information, you can be confident to know that you’ll have it
right there with you.
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Forms, Fields and Records
A Tap Forms database contains Forms, Fields, and Records.

A Form is simply a template which contains a collection of fields that describe the data you wish to capture
and print.

A Field defines the type and title of the data that you want to store. For example, “First Name” is the title for
a field and it would probably have “Text” as the field’s type. Another field might be “Quantity” and it would
probably have the field type of “Number”. There are over 20 different field types to choose from.

A Record is an instance of a Form which contains the actual data values that you are recording. Each value
would be displayed in the fields you’ve added to your form. The title of the field would be displayed next to
the field value.

Tap Forms contains 33 built-in forms ready for you to use and customize. You can even delete them if you
don’t wish to keep them in your database. You can also create new forms from scratch which you customize
to capture exactly the kinds of data you want to keep track of.

Records Display

There are two different views for displaying your records.

1. Single Column List View
2. Multi-Column List View

To switch between each view, select the appropriate option under the View menu or click on one of the View
buttons in the toolbar.

Single Column List View

In single column list view, records are displayed in one column on the screen with each field in the form one
on top of the other. If you have a Photo field as the first field in your form template, Tap Forms will display a
thumbnail of the photo just to the left of the next set of fields.
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Multi-Column List View

In multi-column list view, Tap Forms displays your records in a table view with each column being a different
field in your form. You can scroll horizontally through the columns to view the contents of each field if they
do not all fit within the viewable area.
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There is also a small tools button ( ) just to the right of the table header in multi-column list view which
lets you decide which fields to display in the table. If a field is checked, it will display. If it’s unchecked, it will
be hidden.
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Section Headers and Index

Section headers within your records are used to separate one set of records from another. For example, if
you have a list of customers sorted alphabetically by last name, then Tap Forms will automatically generate
section headers with the first character of the last name. So all “Adams” will be in the “A” section and all
“Smiths” will be in the “S” section.

The section header title is determined by the first character of the First Sort Field. However, if you have a
Date field as your First Sort Field, Tap Forms will automatically group the records into Year and Month
sections. Another way to control the sectioning of records is to set the Group Records By sorting option.
Tap Forms will then display the full values for the selected field for the section titles. For example, in the My
Movie Library form, the records are grouped by Genre, so the records will be grouped together by Action &
Adventure, Comedy, Drama, etc.

On the iOS version of Tap Forms, you can easily jump to different sections in your records list by sliding
your finger up and down on the section index on the right of the records list view. On Mac OS X there’s no
such built-in control, so Tap Forms provides a popup button just to the right of the form name above the
records list view that will let you select which section you would like to jump to.
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When you click the above button you’ll see the popup list of sections.

You can hide the section headers if you don’t want them to appear in the list of records. This may be useful
if you have only a few records and you don’t want Tap Forms to take up the extra space to accommodate
the section headers.

Tap Zapp Software Inc. Tap Forms Mac - 3.0

Page 6 of 78



Using the Built-in Forms

1. Click on the My Forms popup button and switch from the My Forms
item:

to the All Forms item:

You should now see a list of all the built-in forms that are available to you. You may need to expand the
categories to display the list of forms beneath each category heading. Note that if this is the first time you’re
using Tap Forms, most of your forms will have 0 records in them.
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2. Click on a form to select it.
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There are currently no records in the selected form.

3. Click the + button next to the form name in the second column to add a
new record to your selected form.
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Fill in all the fields in your new record.
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Creating a New Form

1. Click the + button at the top-left of the window.

A new form will be created with a default field and the Form Inspector panel will display on the right of the
window.

2. Select an icon for your form and give your form an appropriate name
that represents the content you will be storing.
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You can set a variety of form level properties such as the Category your form will be located in, what the
First Sort Field, Second Sort Field, Third Sort Field, and Group Records By fields will be. You can choose
the sort direction too by clicking on the up or down arrows next to the sort field popup buttons.
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Calculation

If you have any Number, Rating, Checkmark, or Calculation fields in your form, you can use the Calculation
Field and Calculation Type to tell Tap Forms to compute the total, minimum, maximum, or average of the
field that you selected. The results will be displayed at the bottom of the single-column records list view.

Other

Single Column List View Fields is used to tell Tap Forms how many fields to display on the single-column
records list view. You can tell Tap Forms to display the first 1, 2, 3, 4, or 5 fields on the single-column
records list view. If the first field is a Photo field type, then up to 6 fields can be displayed because the
Photo field counts as one field but then you still have 5 additional fields you can display next to the Photo
field thumbnail.

Hide Form tells Tap Forms not to display the form on the “My Forms” list even if there are records within the
form. Normally the “My Forms” list will display forms that have 1 or more records within them. The form will
still be visible in the “All Forms” list. The “All Forms” list displays all forms no matter how many records are
in them.

3. Click the Fields tab and add some fields by clicking the + button below
the fields list.

As you add new fields, Tap Forms will display the properties inspector for each field type you add down
below. Here you can set different field properties such as the field name, field type, number formatter,
decimal places, default value, etc. Each field type has its own unique set of properties you can change.

You can also rearrange the order of fields by dragging them up and down in the fields list. By rearranging
the order of fields, Tap Forms will display them in whatever order you’ve set on the Default Layout and on
the Multi-column List View. You can also delete fields by clicking the delete button next to the add field
button. There is also a duplicate field button which will duplicate the selected field.

Tap Zapp Software Inc. Tap Forms Mac - 3.0

Page 14 of 78



If you drag a Photo field to the first position in your form, Tap Forms will display the
thumbnail of the photo to the left of the next set of fields on the single-column list
view. You can control the size of the thumbnail on the Photo properties view.*
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Field Types

Tap Forms has 23 different field types. Each field type has its own set of properties that can be set in order
to customize the way Tap Forms displays and edits your data.

The following table describes all the field types available in Tap Forms.

Icon Field Type Description

Text Text fields store small amounts of text. Normally a single line’s worth. For example, a
Movie Title.

Number
Number fields display numeric data. They can be configured to format the display as
currency, decimals, percentages, scientific notation, spell out (e.g. “twenty four ninety
nine”), or as a duration (e.g. “10 hrs, 3 mins” or “10:03”).

Date
Date fields will display the month, day, and year. The display format used depends on
your Region Format settings in the System Preferences. In general, Tap Forms uses the
Medium date format to display dates.

Time
Time fields will display the hours and minutes and AM or PM. This also depends on your
region settings. If you have 24 hour mode enabled then you won’t see AM or PM. Tap
Forms uses the Short time format to display times.

Date &
Time

Date & Time fields are a combination of the Date and the Time fields displayed in a
single field. The Date part will use the Medium date format. The Time part will use the
Short format. By adding a Date & Time field to your form, you can also enable the Alerts
function in Tap Forms. With the Alert function you can tell Tap Forms to notify you at the
specified date and time. You can also include a short note which will be displayed along
with the notification. Alerts can be scheduled to repeat at a variety of frequencies. These
options are available when you’re editing a date value in your record.

Date
Created

Tap Forms keeps track of the date a record was created. The Date Created field type
will expose this field to your forms. You can sort by this field or filter your records by this
field.

Date
Modified

Tap Forms also keeps track of the date and time a record was modified. You can sort by
this field or filter your records by this field. Please note however that if you change the
sorting of your form after your form is created, Tap Forms will update the Date Modified
value for each record to be the current date and time. So it’s best to set it once and
leave it.

Audio
Recording

Tap Forms for Mac can play back audio recordings made on Tap Forms for iOS, but it
cannot record audio notes on its own. When you sync with iCloud, Tap Forms for Mac
will gain access to the audio notes you created on iOS.
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Calculation

The Calculation field type lets you construct formulas to compute mathematical
expressions. Formulas can contain references to other fields within your form. You can
use all the basic mathematical operators such as ( ) * / – + as well as the keyword $now.
The $now keyword will insert the current time into the formula before being evaluated.

Checkmark

The Checkmark field lets you have a basic on/off switch for setting whether something is
true or false, on or off, yes or no, etc. Checkmark fields can be used in formulas also.
For example, if you wanted the total to be computed only when a checkmark field is on,
just drag the checkmark field into your formula and use multiplication to cause the result
to be either 0 if it’s off or whatever the regular result would be if the checkmark field
value is on.

Contact

The Contact field lets you reference a contact from your Mac’s Contacts database. Tap
Forms will copy the first and last names into its database as well as the Contact’s unique
identifier. This information will be used to look up the contact’s record from the Contacts
database whenever you click on the contact button to the right of the field. Note: due to
the way Apple syncs contacts across devices, the unique identifier could get changed
between devices. This can cause Tap Forms to display the wrong contact when you
click on the contact button to the right of the field.

Drawing The Drawing field type on Mac is a read-only field. You can create drawings on iOS and
view them on the Mac version. You cannot draw into a field on the Mac version.

Email

The Email field will give you a button to the right of the field which will launch Mail
whenever clicked and pass the email address entered into the field into the To: field of a
new email message. Separate email addresses with commas to address more than one
email address at a time.

File
Attachment

The File Attachment field will let you store one or more files associated with your record.
You can tell Tap Forms if your File Attachment field supports just one file or multiple files
by checking the Multi-File Enabled checkbox on the Field Properties screen. When
Multi-File Enabled is checked, you will see a list of files within your File Attachment field.
You can double-click on a file to launch the app which is responsible for that field type.
You can also choose to attach your file as a copy of the file or as an alias of the file.
When you attach a copy, Tap Forms will copy the file selected into its Attachments
folder. The Attachments folder is synchronized using iCloud to your other devices. So
you will be able to access the same files on your iOS devices and other Macs that are all
using the same iCloud account. Aliases cannot be viewed on other devices.

Link to
Form

This field lets you connect different forms together in a parent to child relationship. Use
One to Many if you don’t want or need to share the records from the linked form with
other forms or records. Use Many to Many if you’d like to be able to select from a list of
previously entered records from another form and link them to the parent record. Enable
the Show Inverse Relationship option if you want to display the parent record on the
child form you’re linking to.

Link from
Form

The Link from Form field will display the parent record that links to the child record. This
field should never be created on its own. It is automatically created for you from the Link
to Form field when you enable the Show Inverse Relationship option.
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Location

The Location field type will display to you a map of your current location. You can search
for different locations and drag the pin around to change your location. You can also edit
the location name, but Tap Forms will first do an address lookup to fill in the address that
matches your current location.

Note
The Note field type allows you to enter in large amounts of text. Text can also be styled
using different fonts, sizes, and colours. The Mac version has the ability to add bulleted
lists, but these are not displayed on the iOS version of Tap Forms.

Phone
The Phone field will convert a set of digits into a formatted phone number taking into
consideration different region formats for phone numbers. The iPhone version will also
dial or text the number when the phone button is tapped.

Photo

The Photo field will let you select a photo from your hard drive or use the built-in camera
to take a photo. You can also drag and drop an image into the Photo field from your hard
drive. Once a photo has been attached to your Photo field, you can click on the
QuickLook button to view a larger version of the photo or click the trash can button to
delete it.

Rating

The Rating field will display up to 10 stars that you can click on in order to rate your
records. For example, if you were maintaining a movie library you could add the film’s
popularity rating to your record. Ratings can be used in calculations and also at the form
level. So you could display the average rating for all the movies in your library.

Section
Heading

The Section Heading field will help you to organize the fields within your form into
sections. This makes working with long forms much easier.

Website
The Website field lets you store an address to a website or even another application on
your own computer. When you click on the website button to the right of the field, Tap
Forms will launch your web browser and take you to the address specified.
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Searching

Tap Forms can perform two kinds of searches.

1. Search across all text and number fields in a form by using a simple search term.
2. Create one or more Saved Searches which target specific fields for filtering your records.

For basic searches, just enter a search term into the Search field:

After you type in a search term, a bar will appear below the Search field with a Save button.

Click the Save button to save the search. Tap Forms will display the search beneath the form on the left
side of the window.

For more advanced searches, click the gear button to the left of the Search field. Tap Forms will display the
advanced search popover where you can add Search Rules which target your search to specific fields.
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Click the + button to the right of a Search Rule to add a new Search Rule.

Click the Save button to save your search. Click the Search button if you don’t want to save your search but
you still want to filter your records.

Deleting a Saved Search

To delete a Saved Search, select your search, then right-click on it and select the Delete Search option. Or
select it and then select the Delete Search menu item from the Forms menu.

When you add multiple Search Rules, Tap Forms will combine each rule together
to reduce the number of records returned from the search. So the more Search
Rules you add, the fewer records will be returned.*
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Categories
Categories are used to group forms together. Tap Forms ships with a few built-in categories, but you are
free to modify them, delete them, or create your own.

To manage your categories:
1. Click on the Tap Forms menu
2. Click on the Preferences menu item
3. Click on the Lists button.

You can drag the categories up and down to rearrange them. The list of forms on the left side of the main
window will update when you rearrange your categories.

Double-click on a category name to edit the name.

Click the + button to add a new category.

Click the – button to delete the selected category.
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If you delete a category, all forms which belong to that category are moved into the
Uncategorized category. You cannot delete the Uncategorized category.*
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Pick Lists
Pick Lists are convenient lists of values that you can use on any Text or Number field in any form. You can
even share the same Pick Lists between different forms and fields. You can create single select pick lists or
multi-select pick lists. They both show the same information but multi-select pick lists allow you to select
more than one value at a time. Single select pick lists allow you to select only a single value at a time.

To manage your Pick Lists:
1. Click on the Tap Forms menu.
2. Click on the Preferences menu item.
3. Click on the Lists button.
4. Click on the Pick Lists button.

To add a new Pick List, click the + button at the bottom-left of the popover. Click the checkbox in the multi-
select column to make the new Pick List a multi-select Pick List. A multi-select pick list will allow you to
select more than one value to assign to a field.

To add a new value to the selected Pick List, click the + button beneath the values list.
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If you have lots of values to add to a Pick List, it would be much quicker to click the Add Values… button
and type your new values into the popover that is displayed. You can even paste values into the popover if
you already have a list of values on your clipboard.

To associate a Pick List with a field:
1. Click the form you want to edit.
2. Click the Form button in the toolbar.
3. Click the Fields tab.
4. Click the field that you’d like to assign the Pick List to.
5. Scroll to the bottom of the properties for the selected field and click the Pick List popup button.
6. Select the Pick List from the popup button.

You will now see the pick list button appear next to the field in the Default Layout, your custom layouts, and
the multi-column list view.
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Layout Designer
The new layout designer makes creating beautiful layouts as easy as dragging and dropping.

To create your first layout, click the + button beside Default Layout

The Layout Inspector panel will automatically display on the right when you add a new layout. But you can
also display and hide the Layout Inspector Panel by clicking the Layout button in the toolbar at the top of the
window:
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The Layout Inspector provides you with tools to customize the layout of your form’s fields and other graphic
elements you might like to have on the page.

The Layout Name property allows you to set the name you’d like to give to your custom layout. The tab
button that represents your layout will display this name. Clicking on that tab will switch to the selected
layout. You can have as many layouts as you would like.

The Design For property allows you to select the purpose for the layout. You have three choices:

1. Screen lets you design a layout which will resize itself to fit the screen the layout is being displayed
on. This is perfect for data entry layouts.

2. Printer lets you customize the design of a single page print layout. This is perfect for designing
invoices, product marketing descriptions, mail merge letters, etc.
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3. Labels lets you create a label template by selecting from more than 1000 Avery® label templates.
You can also customize any of the built-in label templates or create your own from scratch.

The Printer property lets you select which printer you would like to print the layout to.

The Page Size property lets you select a paper size to print to. For example: Letter, Envelope, A4, etc.

The Orientation property lets you select from portrait or landscape. The page size on screen will resize
appropriately according to the Page Size and Orientation properties you select.

The buttons at the top of the Layout Design View let you select a Zoom Level, turn on and off the Text
Inspector, the Rulers, and the Snap to Grid functionality.

To the right at the top of the Layout Inspector panel are the layout design tools.

The Arrow tool lets you select, resize, and drag around the objects on your layout page.

The Line, Oval, and Rectangle tools allow you to draw lines, ovals and rectangles on the page. You can
constrain the line, oval or rectangle by holding down the shift key as you drag a handle around on the page.
You can change the stroke of a line, circle or rectangle to make it thicker or thinner. You can also change
the stroke colour of lines, ovals, and rectangles using the Graphic Properties Inspector which will appear
when you select an object. Ovals and rectangles can also have their fill colours changed.

The Text tool allows you to create blocks of text which will stay the same on every record. This would be
useful for things like company names, addresses, or any other kind of text that you want to remain the same
on every record.

Mail merge. If you enter a field name within square brackets in a static Text block,
Tap Forms will replace the field name and square brackets with the value from the
field for that record when you print your record. For example: “Dear [First Name],
the amount owing on your account is $ [Amount Owing] .”

*
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The Image tool allows you to create areas on the layout which will be filled with any image you have
available on your computer. These images will stay the same on every record. This would be good for things
like a company logo, icon, photo or any other kind of image you want to have on every record.

Layout Properties

The Layout Properites panel lets you change the layout name, what your’e designing your layout for (screen
or printer), set the printer, the page size, and the page orientation.

Fields and Layers

The Fields list shows all the fields that are available to be dragged into the layout area. Below the Fields list
is a checkbox which will tell Tap Forms to automatically create a label for you when you drag a field to the
layout area. Labels will be given the default value of the field name, but they can be changed after they
have been created. You can change label colours, fonts, sizes, and text alignment.

The Layers list shows all of the objects that are already on the page. You can drag these objects up and
down to send them behind or in front of other objects. You can also lock objects so they can’t be moved
around accidentally.

Text Inspector and Alignment Controls

The Text Inspector lets you set fonts, sizes, colours and text alignment (left, centre, right, or full). When the
Text Inspector is visible you also have access to controls for aligning objects on the layout area. You can
select multiple objects and align them all together using these controls.

Objects can have their left edges, right edges, bottom edges, and top edges aligned. They can also be
aligned vertically or horizontally. The Layout menu also gives you some further options for sizing all the
selected objects so they become the same width or height.

The Image tool is different than a Photo field in your form. A Photo field will change
its image with every record while the Image tool’s image will remain the same on
every record.*
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The Text Inspector can also be used when editing a record to set the text properties of a Note field. You can
highlight some text and change the font, the font size, make it bold, italicized, underlined, or adjust the text’s
alignment.

To delete an object from your custom layout, just select it and press the Delete key
on your keyboard. This will only work when the layout inspector panel is visible so
that you’re in layout design mode. To delete the field completely from your form,
click on the Form button in the toolbar, then the Fields tab. Then click on the field
you want gone forever, then press the – button to delete it. If you do that before
deleting the object from your layout, the object on your layout will still be hanging
around, but will be non-functional. So delete it from your custom layout first and
then delete the field itself.

*
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Labels

Tap Forms has a very powerful label design engine built-in. You can select from over 1000 Avery® label
templates, customize the built-in templates, or create your own from scratch.

Before you can select a label template, please create a new custom layout and choose the Labels option
next to the Design for property in the Layout Inspector panel on the right. Once you do that, you’ll see the
Select a Label button appear.

Please see the Layout Designer chapter for more information.

When you click the Select a Label button, the following popover view will appear:
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You can filter labels by paper size or you can enter in a keyword or Avery Product Code to help you find the
label type you’re looking for. Click the Select button when you’ve found the label template you’re looking for.

To customize the selected label or to create your own label from scratch, click on the Edit Label button.
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You can also choose to print the same label per page or you can select the Multiple records per page
option which will tell Tap Forms to print a different record on each label. Printing the same record for each
label would be very useful for printing something like a Business Card where you want the same information
printed on each card. Printing multiple records per page would be perfect for printing Address Labels where
you want a different address on each label.

After you’ve selected or edited your label format, it’s time to drag fields into the layout designer area and
customize the design of your label. To get a larger view of your labels, adjust the zoom level to be higher
than 100%.

If you don’t see the Multiple Records Per Page option, drag the horizontal divider
bar on the layout inspector panel down a little bit to reveal that option.*
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To print your labels, select the Print function from the File menu and make sure you
have the Details (1 record per page) option selected. Note, if you have Multiple
records per page enabled for your label, you will still get multiple records per page
printed, despite what the Details option says.

*
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Bento Template Importer
Tap Forms for Mac includes a Bento Template Import command to help you migrate from Bento to Tap
Forms. Bento has been discontinued by FileMaker and is not fully compatible with OS X 10.10 Yosemite.

To import your Bento template in Tap Forms:
1. Launch Bento and select your library.

Tap Forms will import Bento 3.0 to 4.1 version templates. However, you will need
version 4.0 or higher of Bento in order to be able to export your Bento data along
with your templates. For optimum compatibility, please download the Bento 4.1.2
update from here: http://help.filemaker.com/app/answers/detail/a_id/11182

!
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2. Select Export… from the File menu and choose the Template option.

Make sure you click on each related library displayed in the “Include these related libraries” list if you want
Tap Forms to be able to join your related forms together. Also click on “Include records in template” if you
want Tap Forms be able to import your Bento data also.

3. Save your template.

If you don’t see the “Include records in template” option, then you’re not using the
latest version of Bento. You’ll need to download that first before proceeding. The
link is at the top of this page.

!
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4. Launch Tap Forms and select the “Import Bento Template” command
from the File menu and select your Bento template file.

Click the Choose button when you’ve found your Bento template.

Tap Forms will now import your template and records.

If your template contains more than one related form, Tap Forms will automatically create a new category
for you and put your related forms together inside that category. The category will be given a name based
upon the file name of the template you are importing.
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You will need to expand the category to view the forms by clicking on the triangle just to the left of the
category name.

Once you’ve imported your Bento template, you can click on any of the layouts that
Tap Forms generated from the Bento library. You may need to reposition some
elements and/or make some adjustments to the font sizes and styles. Also, the
Date Created and Date Modified fields are usually the first fields that get
imported, so if you don’t want them there you can just delete them in Tap Forms or
move them down the list of fields in your form. Otherwise they’ll be the first two
fields which show up in the records list view. Most likely not the desired result.

*

Tap Zapp Software Inc. Tap Forms Mac - 3.0

Page 37 of 78



Bento Fields in Tap Forms

The following table describes how Tap Forms imports Bento forms and fields. Field types not on this list are
not supported in Tap Forms.

Bento Tap Forms

Form A Bento form is converted to a Tap Forms layout. Once you’ve imported a Bento template, you
can further customize the layout in Tap Forms or add additional layouts to meet your needs.

Text

Bento text fields can be one or more lines long. Tap Forms has 2 different text field types.
• Text fields are used for shorter one-line bits of information, such as a Movie Title.
• Note fields are used for larger amounts of text, such as a Movie Synopsis.
• Tap Forms will convert Bento text fields into Text or Note fields depending on the height

of the field in the Bento form.
• Tall fields in Bento will be converted to Note fields in Tap Forms.
• Small fields in Bento will be converted to Text fields in Tap Forms.

Number Bento Number fields are converted to Number fields in Tap Forms. The Number Formatter is set
to Decimals.

Currency

Bento Currency fields are converted to Number fields in Tap Forms. The Number Formatter is set
to Currency and the Decimal Places is set to 2. Note: Tap Forms supports only the currency that
you have by default according to the system’s regional settings. For example, in Canada, all
currency values will be in CAD. In the UK, all currency values will be in GBP.

Counter Counter fields are converted to Number fields.

Duration Duration fields are converted to Number fields with the Number Formatter set to “hours, mins”.

Rating Rating fields are converted to Tap Forms Rating fields.

Dates and
Times

Times are converted to Time fields. Dates are converted to Date fields. If the Date field has the
flag to show the Time set, then it’s converted to a Tap Forms Date & Time field.

Media Media fields are converted to Photo fields. The photo file is also extracted and copied into the Tap
Forms Photos folder.

Checkbox Checkbox fields are converted to Checkmark fields.

Choice Choice fields are converted to Text fields. The values in the Choice field are converted to a Pick
List and associated with the Text field.

Note: The Simple List field type in Bento is ignored when you import your Bento
template into Tap Forms since that type is not supported by Tap Forms.!

Tap Zapp Software Inc. Tap Forms Mac - 3.0

Page 38 of 78



Calculation

Calculation fields are converted to Calculation fields. Tap Forms makes a best guess at trying to
convert the Bento formula to a Tap Forms formula, but it’s not going to be very accurate since
Bento supports more calculation options than Tap Forms at this time. You will probably have to re-
do your calculation formulas after the migration.

Location Locations fields are converted to Location fields. The longitude and latitude values are also set as
the location name in Tap Forms.

Phone Phone number lists are converted to a Phone field in Tap Forms. Only the first phone number is
imported. All other phone numbers in the list are ignored.

Email Email lists are converted to an Email field in Tap Forms. Only the first email address is imported.
All other email addresses in the list are ignored.

URL URL fields are converted to a Website field. Only the first value is imported. All other URL values
are ignored.

Related
Records

Related Record fields are converted into Link to Form fields with the Many to Many Link Type set.
Tap Forms also re-establishes the relationship data between forms.

File List File List fields are converted to File Attachment fields with the Multi-File Enabled setting turned on.
Files are copied into the Tap Forms Attachments folder.

The Bento Template Importer will be improved over time as new features are added to Tap Forms which
match some of the features previously available in Bento.
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Import Records
Tap Forms provides a wide variety of options for importing data from other applications. You can import both
CSV text files and Excel XLSX worksheet files.

Before you can import a CSV file to Tap Forms you must export it from another app to a text file. The text
file can have a .csv (comma separated values), .txt (text), or .tsv (tab separated values) file extension.
These file types are all pretty much the same but contain slightly different column delimiters. Just make sure
whatever column delimiter you use in the file, you set Tap Forms to use the same column delimiter.

Importing XLSX files requires only that you have the first row in your Excel file be the names of the fields
you would like to be in your form. Tap Forms will also only import the first sheet of data from the XLSX file.
Make sure your data is structured as regular rows and columns. Tap Forms will not import any formatting
information from an Excel worksheet file. The benefit of an XLSX file is you don’t have to worry about things
like column delimiters, line endings, or file encodings.

Choose File
The first thing to do is click the Choose file button and then select a file you wish to import.

When you import a CSV file, Tap Forms uses the first row of your file as the field
names to create when you choose the New Form option. If you choose an existing
form to import your records into, you must make sure that the first row values
match the field names exactly as you have them named in your form. Otherwise
Tap Forms will create a new field for every value in the first row which does not
match a field name in the form you’re importing into.

*

You should also make sure your field names are unique in the header row. Tap
Forms uses the names of the fields in the first row to match up with the fields
created in your form.*
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File Encoding
It’s very important to set the file encoding setting correct for the file you’re trying to import. If you don’t set it
correctly, Tap Forms won’t be able to understand all the characters in the file you’re trying to import. This
will most likely manifest itself in Tap Forms importing fewer rows than are actually in the file. Another issue
that you might notice is strange garbage characters appearing instead of properly accented characters.
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Column Delimter
Tap Forms supports the following set of column delimiters: comma, semi-
colon, tab, and pipe. Column delimiters help tell Tap Forms how to
distinguish one field’s value from the next. If you have a delimiter within
your data then you must put double-quotes around the value. For example
“Rolling Stones, The”. Because there is a comma in the value, the entire
value must be surrounded with double quotes. Mostly you never have to

worry about this sort of thing because programs like Excel and Numbers should automatically put double
quotes around any data that contains a column delimiter within it. Tap Forms does then automatically when
you export records.

Date Format
When you have a file that has dates in it, Tap Forms needs to be
told how to interpret the date values. Is it month, day, year, or day,
month, year? In order for Tap Forms to understand the date
values in your file, you must tell it what format your date columns
use. Tap Forms only understands date formats that are numeric
based. So if you have a date in your file like “Dec 10, 2013” then
you need to convert that to be “12/10/2013” or some other
variation on a numeric date format. As long as it follows one of the
formats displayed in the list of date formats in Tap Forms.

There are a couple Date & Time formats in the popup menu also. You can use these if your date has a
combined date & time value within it that has the date and time separated by the letter T. For example,
when Bento exports its Date & Time values it uses this format: yyyy-MM-dd’T‘HH:mm:ss

File encoding is just a way of describing to a computer which characters the data in
the file represents. When you open a text file we just see characters, words and
sentences. But to a computer, the file contains just a bunch of numbers all strung
together. File encodings tell a computer what characters to display on screen when
it encounters different numbers in a text file. For example, the character A is
number 65, B is 66, and so on when using the ASCII file encoding format. UTF-8 is
the most sensible file encoding to use because it can encode characters from any
language on Earth. However, if you’re importing from a Windows PC that exported
a CSV file using Excel, you most likely want to use Windows Latin 1. On the Mac
you may need to use Mac OS Roman file encoding.

*
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Time Format
Time formats follow the same principal as date formats. Just make sure
your time format is set to be the same format as what is contained within
your CSV file.

Select a Form
You can either enter a name for a new form to be created, or if you already have a form that you’d like to
import your CSV file into, select it from the list of available forms. If you select New Form, Tap Forms will
create a new form for you using the field names from the first row of the CSV file.

Assign Field Types

It’s important to tell Tap Forms before you import a CSV file what the field types are that it is importing. This
helps Tap Forms to properly interpret the data being imported. If you don’t do this and you try to change
field types after then Tap Forms will appear to lose the values in the field for which you changed the type.
The data is not gone, it’s just stored in a different column in the database.

Record Navigator
Click the record navigator to flip through the records in your CSV file. This will
help you to determine if you have your file encoding, column delimiter, and your

date and time formats set correctly.

Click the Import button when you’re ready to start the import process.

Tap Forms stores text data in a different column than it stores dates, numbers,
location, or checkmark data. There are some fields which you can safely switch
types. For example, switching a Text field to a Note field is safe. Switching a Rating
field to a Number field is safe. But switching a Text field to a Date field is not safe.

*
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Export Records
Along with importing CSV files, Tap Forms can generate CSV files so you can use your Tap Forms data in
other applications.

To export your records, click the File menu and select Export Records…

The various options on the Export Records screen tell Tap Forms how to generate the file that you’ll import
into other applications.

File Encodings
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As in the Import Records function, you can tell Tap Forms to export your file in a
variety of file encodings. UTF-8 is generally the best encoding to use as it
supports encoding characters in all languages. It may depend on the program you
want to import your data into that dictates which file encoding you should use.
Check the other program to see what file encodings it supports.

Number Formats

Tap Forms can also export Number fields in a variety of
different formats. For the Currency format, Tap Forms
will use your regional number format settings to
determine what currency symbol to use during the
export. For example, in Canada and the USA currency
numbers will be exported like $29.99, but in Europe the

same value would be exported as 29.99 €.

Export Record ID

By enabling this option, you’re telling Tap Forms to export the values that uniquely identify each record in
your form. Tap Forms will add a column called form_record_id to your CSV file. If you import a file into Tap
Forms which has a form_record_id column, it will search for matching records and update their field values
rather than adding new records to your form.

Export Linked Records

With this option enabled, Tap Forms will generate separate files containing the records from any linked
forms. If you want to import these files into another copy of Tap Forms, make sure you import the parent
form’s CSV file first and then import the child records. That way Tap Forms will be able to join up all the
child records to the parent records.

Field Type Tags

By turning on Field Type Tags, you’re telling Tap Forms to generate a header row that contains a tag that
identifies the field’s type.

The following are the tags that Tap Forms will generate

Tag Field Type

<text> Text
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<number> Number

<date> Date

<time> Time

<date_time> Date & Time

<check_mark> Checkmark

<contact> Contact

<web_site> Website

<note> Note

<photo> Photo

<audio> Audio Recording

<phone> Phone Number

<rating> Rating

<location> Location

<email> Email Address

<calc> Calculation

<file> File Attachment

<form> Link to Form

<draw> Drawing

<section> Section Heading

<date_created> Date Created

<date_modified> Date Modified

For example, a CSV export file of a movie library form would look something like this:

Movie
Title<text> , Release

Year<number> , Synopsis<note> , I Watched
This<check_mark>

Terminator
2:
Judgement
Day

, 1991 ,

The cyborg who once tried to kill Sarah Connor is
dead, and another T-101 must now protect her
teenage son, John Connor, from an even more
powerful and advanced Terminator, the T-1000.

, 1

Export Media
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When you enable this flag, Tap Forms will generate a zip file that contains your records in CSV files and
also a folder within the zip file that contain all of the media referenced in your records. Each media type will
have a separate folder named with the name of the form being exported and the media type. For example
“My Work Expenses-Photos”, “My Work Expenses-Files”, etc.

At the moment, file attachment fields with the multiple files setting enabled won’t
get exported into the zip file. That feature is coming in a future update.!
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Backup & Restore
From the File menu, select Backup… to have Tap Forms generate a backup file for you.

Backups have file names that start with TF and end with .zip. The file name also contain the name of your
computer and the timestamp of when you selected the Backup command. Backup files are just compressed
files that contain your database file, photos, drawings, audio recordings, and file attachments. So you can
double-click on one to uncompress it to see what’s inside.

Choose the Restore command to select a backup file and restore it over top your current database.

Restoring will erase all the data in your current database and replace it with the
data from the database file contained within the backup file.!
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iCloud & Dropbox Sync
Tap Forms uses iCloud or Dropbox to sync data between your devices. For iCloud sync, Tap Forms uses
the iCloud Drive service. So before you can enable iCloud sync in Tap Forms, please make sure you have
iCloud Drive enabled in the iCloud settings on all your devices. For Dropbox syncing, please make sure
you’ve installed the Dropbox app for your Mac and iOS devices.

Enable Sync in Tap Forms on all your devices.
1. Click Preferences from the Tap Forms menu.
2. Click the Sync button.
3. Choose a Sync Service (iCloud or Dropbox).
4. Click the Cloud Sync button in the toolbar on the main window.
5. Click on the Enable Sync checkbox.
6. Do the same on your other devices.
7. You will see each registered device listed underneath the Registered Devices list. You may need to

close the Cloud Sync popover and reopen it for the list to refresh on the Mac version.

iCloud sync is not available on the direct download version of Tap Forms Mac. This
is because Apple doesn’t allow apps with iCloud to be installed outside of the Mac
App Store. It’s a technical restriction, not a choice.

!
You will now need to set the encryption key to the same value on all of your copies
of Tap Forms before you can sync between your devices. If you don’t do that you
will encounter a Sync Failed message. The Sync Failed message lists the things
you need to do in order to get sync working.

!

OS X 10.10 Yosemite is required to sync with iOS 8. This is because iCloud Drive
is not supported on OS X 10.9 or iOS 7 and earlier. However, if you use Dropbox
for syncing, you can sync between Mavericks and Yosemite.

!
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If you don’t see all the devices you’ve enabled sync on in Tap Forms on the list of
Registered Devices, then reboot all your devices. On iOS do a complete power off
and then power on. Then check the list again.*
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Whenever you want to send the changes you’ve made on your Mac to your other devices, click the upload
to cloud button at the bottom-right of the window or in the Cloud Sync popover view. Uploading to the
cloud is a manual process. The upload to cloud button is used ONLY for uploading your data to the cloud.
Downloading from the cloud is an automatic process. You don’t need to do anything to trigger a download
from the cloud. Think of it like a game of ping pong sending your data back and forth from device A to
device B back to device A, etc.

Sync in Action

Watch this Youtube video to see how iCloud sync is used in Tap Forms. The process is the same for
Dropbox once the setup is complete.

Reset Sync

Sometimes your devices may get out of sync. To get them back in sync again, please follow this procedure
exactly. If you don’t have a Mac, just substitute one of your iOS devices for the Mac in these instructions.

1. Press Reset Sync on your Mac.
2. Press Reset Sync on your iOS devices.
3. Wait a minute or two for the cloud to notice these changes.
4. Re-enable Cloud Sync on your Mac and your iOS devices.
5. Wait for all devices to appear in the list of Registered Devices on each device. So all devices should

“see” each other.
6. Press the upload to cloud button only on your Mac or iOS device that has all the most up-to-date

records.

When you register a device with the cloud, your files will be copied from your
device into your iCloud or Dropbox storage space. Depending on the size of your
files (Photos, audio recordings, files in the Files area, etc.) and the number of
them, it may take quite a while for them to be uploaded and synced to your other
devices. During this time, the Cloud Sync popover may take considerable time to
return the list of registered devices to you. Please be patient and wait a while
before trying again. You can continue to use Tap Forms while this happens
automatically in the background.

*
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7. Wait for your other devices to auto-sync. DON’T press the upload to cloud button on those other
devices while you wait for the auto-sync to kick in.

8. Press the upload to cloud button only on the one device at a time. DON’T press the upload to cloud
button on any other device. Just wait for the auto-sync to kick in on your other devices.

You should now be in sync again. From now on, just do it like that. Make changes on one device and press
the upload to cloud button only on the device you made changes on. Let your other devices auto-sync those
changes.
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Relationships
Tap Forms has the ability to link forms together to establish relationships between them. There are currently
two types of links:

1. One to Many
2. Many to Many

To make it easier to identify what is being talked about in this section of the documentation, I’ll refer to the
main form as the parent form. Any form that the main form links to will be called the child form.

One to Many

The One to Many link type is useful in situations where the child form’s data is unique to the parent record
it’s linked to. That is, no two parent records should link to the exact same records from the child form. It’s
easiest to describe this situation using an example.

Keeping Track of Clients and Expenses

If you wanted to keep track of all the expenses you incur when working for a specific client, you wouldn’t
want those expenses to be linked to any other client than the one for whom you are currently working. A one
to many relationship is useful in this situation. One client has many unique expenses which are attributable
only to it.

Create a Client Expenses form:
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Create a Clients form and link it to the above Client Expenses form:
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Make sure you’ve selected One to Many as the Link Type.

A note about the Show Inverse Relationship option. You can enable the Show
Inverse Relationship option if you would like Tap Forms to manage both sides of
the relationship for you. Enabling the Show Inverse Relationship option will
automatically create a Link From Form field which will show you which parent
record linked to the record you’re viewing. In our example that means a Client
Expense record will display a field that links back to the Client form so for any
selected Client Expense record, you’ll easily be able to see which Client it belongs
to.

*
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Now when you add or edit a record on your Client form, you can see the list of Client Expenses. Initially
there will be none, but you can click the + button above the list of Client Expense records to add one. By
adding a record from this view Tap Forms will link the new Client Expense record to the parent Client
record.

When you add a child record to the parent record form, Tap Forms will switch the display to the child form
(in this case Client Expenses) along with a back button which when clicked will return you to the parent
record from where you came.

Many to Many

Don’t create your own Link From Form field. Tap Forms will create it and set it up
properly for you when you enable the Show Inverse Relationship option.!
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An example of a Many to Many link could be a list of team members who are assigned to projects for the
selected Client.

Add a Team Members form that contains a list of people that work at your company. You
could add their name and job title.

Now add the linked form field to the original Clients form:
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Make sure you click on Many to Many for the Link Type and select the Team Members form from the Link
to Form property.

Now when you view your Client record the list of Team Members will initially be empty:
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After you’ve added some Team Members you’ll be able to select from the list of Team
Members by clicking on the checkmark button just below the linked field.

This will display a popover with a list of child records which haven’t yet been linked to your parent record.
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Select one or more records from the popover and then click the Select (#) button.
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The list of linked records will update to show the records you’ve previously selected and the records you’ve
just selected.

And that’s the difference between a One to Many and a Many to Many Link to Form field.
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Menu Commands
Tap Forms gives you the ability to perform a variety of commands on forms, records, and layouts. For
example, you can delete a form, duplicate a form, share a form template with others, and import a form
template you’ve been given by others. You can create new records, delete records, duplicate records.

File
The File menu contains a variety of commands for exchanging your data
with others. It contains commands for importing records, exporting records,
importing form templates, exporting form templates, importing Bento templates,
backing up your database, restoring your database and printing your forms. Other
topics in this guide will go through each of these options in detail.

View
The View menu lets you switch between different views. You can switch
between the All Forms and My Forms lists of forms and between the Single-
Column and Multi-Column records list views.

Forms
To delete a form, select a form and click the Forms menu. Then select the
Delete Form command.
When you delete a form, Tap Forms will delete all of the records and all of the
photos and files associated with the records in the form.

To duplicate a form, select a form and click the Forms menu. Then select
the Duplicate Form command.
When you duplicate a form, Tap Forms duplicates just the form template, not any
of the records. Custom layouts are also duplicated along with the form template.
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You can also access these commands by right-clicking on the selected form in the My Forms or All Forms
list.

Records
To delete a record, select a record and click the Records menu. Then select
the Delete Record command.
When you delete a record, Tap Forms will delete all of the photos and files
associated with the selected record.

To duplicate a record, select a record and click the Records menu. Then
select the Duplicate Record command.
When you duplicate a record, Tap Forms will duplicate all of the photos,
drawings, and audio recordings associated with the record. File Attachments will
not be duplicated at this time.

You can also access the Duplicate and Delete commands by right-clicking on the selected record.

Go To
You can use the keyboard to quickly navigate between records. Command-]
will move to the next record. Command-[ will move to the previous record.
Command-shift-[ will move to the first record. And command-shift-] will move to
the last record in your form.

Layout

After you’ve made a duplicate of your form, you will not see the default or custom
layouts displayed just yet. To see these views, press the + button on the records
list view to create a new record. Once a new record has been created in your form,
the Default Layout and any custom layouts that were in the original form will also
be displayed.

*
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The layout menu provides a variety of commands for managing your custom
layouts. From here you can edit layouts, duplicate layouts, delete layouts and
perform a variety of commands on items in your custom layouts.

Tools
The tools menu just gives you an alternate way of
gaining access to the Pick Lists popover, the
Categories popover, and the iCloud Sync popover.
You can also access the Switch Languages function
here.

Switch Language
Tap Forms supports a variety of languages. By selecting a language here, Tap
Forms will translate the built-in forms and fields into the language selected.
Regular user interface items such as menus, buttons and other text in Tap Forms
will display automatically based upon your computer’s language setting. Tap
Forms only supports the languages listed here.
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Barcodes
Tap Forms can now generate and print 24 different kinds of barcodes.

The following barcode symbologies are supported:

Coda bar Code 39 modulo 43 Facing Identification Mark Pharmacode One Track

Code 11 Code 93 Interleaved 2 of 5 POSTNET

Code 128 EAN 13 ISBN QR Code

Code 39 EAN 2 Supplement ISMN Standard 2 of 5

Code 39 Full ASCII EAN 5 Supplement ISSN UPC A

Code 39 Full ASCII modulo 43 EAN 8 MSI (Modified Plessey) UPC E

To configure your barcode:
1. Click on the Form button in the toolbar.
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2. Click the Fields tab.
3. Find the field you would like a barcode generated for and click on it.
4. Click on the Display as Barcode checkbox in the field’s properties pane down below.
5. Click on the Edit Barcode button.
6. Select a barcode symbology. You can enter sample text to see how it will look.

To display your barcode:
1. Follow the instructions in the Layout Designer topic to create a new custom layout.
2. Drag your barcode field into your custom layout.
3. Resize your barcode to fit the area required.

A great use of the new labels feature is to put a barcode onto a label and print them out to stick them on
anything you want barcodes on.

To print your barcodes:
1. Select the custom layout which contains your barcode.
2. Select the Print command from the File menu.
3. Click the Print button.
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If you’re printing just a single label on one page, select the Print selected records option. If you want to
print different barcodes for each label, select the Multiple records per page option for your label and then
select the *Print all records” option on the Print sheet.
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Printing
Tap Forms has 4 different ways of printing your records:

1. Record Details with the Default Layout
2. Record Details with a Custom Layout
3. Table of records in a list format
4. Labels in a grid format

To print your data, click on the File menu and then click on the Print menu item.

1. Record Details with the Default Layout

The benefit of printing the Default Layout is that it’s quick to get a nice printed report of your record details.
Also, if a single record is quite long, Tap Forms will intelligently span the printout of the record across
multiple pages, avoiding cutting off the contents of an individual field across pages.

Initially when you display the Print sheet, it will appear with only the very basic print settings.

To see the advanced print settings, click on the Show Details button.

You can also use the Fields list to select which fields you would like to print or not print. Tap Forms will
make sure there are no gaps in the printout as you enable or disable different fields.
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The print sheet will expand to display many more options for printing, including a variety of Tap Forms
specific options.
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The top area of the print sheet contain standard print settings that are available in most apps. You can
select the printer, the number of copies, which pages to print, the paper size, and the paper orientation.

The bottom area contains options specific to Tap Forms.

Most of the options in the Tap Forms area are only relevant for printing the Default Layout and the Table of
records layout. They have no effect on printing custom layouts other than the following options:

1. Print selected records – to print just the records you’ve selected in the records list view.
2. Print all records – no matter how many records are selected.
3. Print field borders – to enable or disable printing of any borders around fields in your custom layout.

2. Record Details with a custom layout

There’s not much difference in the print sheet when you’re printing a custom layout.
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3. Table of records in a list format

If you need to print multiple records per page in a list format with headers and footers, then use this print
layout. Tap Forms will print as many columns as will fit on a single page width. You can change to
landscape orientation to get more room to print additional columns. You can also enable or disable different
fields to print on the list view.
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Most of the options on the print sheet will have some effect on the printout. For example, you can enable or
disable the printing of the form name, the date, the time, and choose whether or not you want alternating
light and dark row backgrounds for your records.

4. Labels in a grid format

If you switch to the Multi-column List View before you print, Tap Forms will use the
column widths you’ve specified there for the column widths of the printout when
printing the table of records. By adjusting the widths of the columns when viewing
your list of records, you can control how the table of records is printed. This may
help you to get more columns printed on the page than would otherwise be
possible.

*
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Preferences
To access various other settings for Tap Forms, click on the Tap Forms item in the menubar at the top of
the screen, then click on the Preferences menu command.

There are 4 preference panels to select from:

1. General
2. Lists
3. Security
4. Maintenance

General

There are 3 functions to perform on the General preferences panel:

1. Reset dialogue warnings. If you suppress warnings on any of the dialogues you may want to see them
again, so click this button.

2. Ruler Units. This is for the units displayed in the ruler on the Layout Designer view.
3. Backup & Restore. You can tell Tap Forms to backup when you quit the app, how many backups to

maintain, and whether or not media files will be stored in your backup file. You can also perform a
backup or restore a backup file. The Show Files button will also show you the backup files on your
drive.
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Lists

This is where you configure your Categories and Pick Lists. See the separate Categories and Pick Lists
topics for more on these.
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Security

This is where you set an encryption key, encrypt the database, set the auto-lock option and set a lockout
interval..

If you enable iCloud sync, you will need to come here and set the encryption key. It
must match the encryption key you set on all the other devices you’ve registered
with iCoud sync. If you don’t have the encryption key set, you will most likely
receive a Synchronization Failed error message telling you to set the encryption
key.

*
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Auto Lock tells Tap Forms to lock Tap Forms if you haven’t used it after a set number of minutes that you
can configure.

If you’ve already set the encryption key, you can change it here by clicking on the Change Encryption Key
button.

To encrypt the entire database, click on the Encrypt Database button. If your database is already
encrypted, you can decrypt it by clicking on the Decrypt Database button.

If you’ve forgotten your encryption key, launch the Keychain Access application
on your Mac, search for Tap Forms, then double-click on the Tap Forms application
password entry. Next, click on the Show password checkbox button. You’ll be
asked to enter your computer’s password then you’ll see your encryption key
displayed. The Keychain Access application can be found by typing Keychain
Access into the Spotlight search field or by launching it from the Utilities folder
(which is inside your Applications folder) in the Finder.

*

If you’ve forgotten your encryption key and you don’t see it in the Keychain Access
application, there’s no way to recover your data. So make sure you never forget
your encryption key or you have a copy of it stored in another secure location.

!
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Maintenance

Tap Forms uses the SQLite database engine for storing its data. There are various maintenance tasks
which can compact the database file and re-index the content helping to improve the performance of the
application.

The Maintenance screen is where you can perform the following database maintenance tasks:

1. Vacuum Database. When you add forms and records to Tap Forms, the database file size will
increase. You would naturally think that if you deleted data, the size of the database file would
decrease. However, that’s not the case. When you delete data, the space used is simply marked as
available for new data. If you add a lot of data and then delete a lot of data, the file size can grow to
be quite large. If you do that enough, the database file size will much larger than it needs to be.
Vacuuming the database will compact it and give you a much smaller file. Smaller files also help to
increase the performance.

2. Analyze Database. SQLite maintains statistical information about the data stored in the database
which can help it to improve the performance of queries. If it takes too long to retrieve some records in
a form, running the Analyze Database process may help to improve the performance of this.

3. Re-index Database. This command will tell SQLite to regenerate all the indexes in the database. It
may help to improve performance in some situations.

4. Re-build Search Index. If you find that searching for specific values that you know are in your forms
returns no results, trying clicking the Re-build Search Index button and that should fix it up.
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